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9 Unsolved
Section A: (Objective Type Questions)
A. 1 b 2. a 3. b 4. b 5 b
B. 1. Formatting 2. Full Screen 3. Save As
4. Print Preview 5. Dialog box
C. 1. True 2. False 3. False 4. False 5. False

Section B: (Subjective Type Questions)

A. 1. Three different types of documents created in Mail Merge are: Main Document, Data
Source, and Merged File/Form Letter.

2. Three important features of word processors includes,
 Easy typing and word wrapping feature
« Spelling and Grammar Check

¢ Mail Merge Feature
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Thesaurus contains the similar meanings or opposite meanings of a word.

To remove a formatting, you need to first select the text and then select the Clear Direct
Formatting option from the Format menu or Press the Ctrl + M shortcut key.

Different types of the case conversion present in Writer are: Upper Case, Lower Case, Cycle
Case, Sentence Case, Capitalize Every Word, Toggle Case, and Small capitals

The Undo option lets you delete the last change made in the document. Different ways
to use the Undo option are as follows:

« Click on the Edit menu — Undo option from the menu bar.

+ Click on Undo button present on the Standard toolbar. This button has a drop-down
arrow to allow you to undo multiple previous actions. Click on the drop-down arrow,
next to Undo button, a list of all the separate actions performed will appear. Then hold
the down arrow key to select as many previous actions as you want and press the Enter
key to delete them.

To use Find and Replace option, follow the given steps:

Step 1:

Step 2:
Step 3:
Step 4:

Step 5:

Step 6:

Step 7:

Step 8:

Click on Edit menu — Find and Replace option or press Ctrl + H using Q
keyboard. The Find and Replace dialog box will appear.

Type the text you want to find in the Find box.
To replace the text with different text, type the new text in the Replace box

You can check on Match case check box if you want to match the word with
uppercase/lowercase.

You can check on Whole words only check box if you want to search for the
whole word and not a part of any other word.

Since both the above are checkbox then you can select both the options together,
it will search for the whole word only and will match the specified case also.
When you have set up your search, click on Find All button to select all the
occurrences of the specified searched word in the given document.

After the text is found we have a choice of replacing it with a new word only at
the first match by selecting Replace button or replacing all the matches with the
new word by clicking on Replace All button.

To correct the incorrect spelling, follow the given steps:

Step 1:

Step 2:

Right-click on the word with a red wavy line. A shortcut menu will appear. It
suggests a list of words for replacement which you can choose.

Click on the suitable word to replace it with incorrect word.

To check spelling, you can also follow these steps:

Step 1:

Click on Tools menu — Spellings option. The Spelling dialog box will appear.
OR



Step 2:
Step 3:

Step 4:

Click on the Check Spelling button on the standard toolbar. The Spelling dialog
box will appear.

Choose the correct spelling from the Suggestions list.

Click on the Correct button, to change the spelling. The next incorrect spelling
will be highlighted and the Suggestions list will change accordingly.

OR

Click on Correct All button, to change all the incorrect spelling in one click.
OR

Click on Ignore Once button to ignore the incorrect spelling of the selected word.
OR

Click on Ignore All button to ignore the incorrect spelling of all the incorrect
words.

OR

Click on Add to Dictionary button, in case a correct word is highlighted as an

incorrect word and you want to add it in the existing dictionary. In this way, next
time it is not marked as wrongly spelled word.

Click on Close button, after completing the desired action.

To insert an image in a document, follow the given steps:

Step 1:
Step 2:

Step 3:

Place the cursor in the document where you want to insert the image.
Select the Insert menu — Image option. The Insert Image dialog box will appear.
OR

Click on the Insert Image button from the standard toolbar. The Insert Image
dialog box will appear.

Select the image and click on the Open button.

The selected image will be inserted at the desired position.

To help your friend add the “1" in a Writer document, you can guide them through the
following steps:

Step 1:
Step 2:

Step 3:
Step 4:

Place the cursor in the document where you want to insert special character.

Click on the Insert menu — Special Character option. The Special Characters
dialog box will appear.

Select the required special character.

Click on the Insert button.

To add background colour to the paragraph, follow the given steps:

Step 1:
Step 2:

Select the paragraph.

Select the Format menu — Paragraph option — Area tab — Color option.
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Step 3:
Step 4:

Select the desired background colour.
Click on the OK button.

The selected colour will appear in the page background.

2. To merge the cells, follow the given steps:

Step 1:
Step 2:

Select two cells of the first row in the table.
Click on the Table menu — Merge Cells option.
OR

Right-click on the selected cells. A shortcut menu will appear. Click on the Merge
Cells option.

The cells will be merged.

Step 3: Type the heading of the table in the merged cell.

4. Electronic Spreadsheet
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1l c
6. d 7. d
B. 1. Name Box
4
1

. Shrink to fit cell size

. False 2. False

8 Unsolved

Section A: (Objective Type Questions)

3. ¢ 4. a 5.d

8. a 9. b 10. ¢

2. Input Line 3. Cell Address
5. Status Bar

3. False 4. False 5. True

Section B: (Subjective Type Questions)

A. 1. Thetools present in the formula bar are as follows:

« Name Box

» Function

+ Function Wizard + Input Line

e Sum
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Absolute referencing, Relative referencing, and Mixed referencing.

The Autofill feature helps you fill a predictable series automatically in a range of cells using
the fill handle.

4  a

b.

5 a

@ ™o o
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¢
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In cell E20, the value will be 0.
The formula displayed in the formula bar will be =C20 - D20 after copying.

If A3 is changed to 5, the formula in D3 will automatically recalculate using the new
value of A3. Now, the cell D3 displays 8.

If B3 is deleted, it becomes empty (blank). In Excel, a blank cell is considered 0 in
numeric operations. Now, the cell D3 displays 2.

D4=B4*C4, is to find the amount paid for Jeans.

Select the Cell D4 and then drag the fill handle down to Cell D8 to copy the formula
to cells D5 to D8 and adjust the cell references accordingly.

D9=SUM(D4:D8), to found the total amount of all the items
« This adds up all the values in the “Amount” column (cells D4 to D8).
C9=MAX(C4:C8), to find the most expensive item
C10=MIN(C4:C8), to find the most inexpensive item
C11=AVERAGE(C4:C8), to calculate the average price of all the items
A9= COUNT(A4:A8), to count the number of items
To represent the data using a suitable chart, follow the given steps:
Select the range A4:D8.
Click on the Insert — Chart option from the Menu bar.

Select the desired chart type. In this case, we have selected the column chart with
3D look.

It will insert a chart and then you have a choice whether you want to finish the steps
or format it by following the next three tabs- Data Range, Data Series, Chart Elements.

Click on the Finish button to close the Chart Wizard. A chart will be inserted.
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a. Thevalue in cell C1 will be 44.

b. The formula in to find the smallest value in the cell range A1:D1 is =MIN(A1:D1)
The value in cell E1 will be -40.

¢. Theformulain cell D3 is =$B3 + C3
When we copy this formula in cell E3, then the formula in cell E3 will be =$B4+C4.

To depict a comparison of population growth in various countries over the last 10 years
diagrammatically, the Biology teacher should use the Chart or Graph option available in
the spreadsheet software. Charts are effective visual tools that help in comparing data and
identifying trends over a period of time.

Two different types of charts used to compare data are:

« Column Chart: It displays the data with categories represented by a vertical rectangle.
It helps in comparing a number of items and trend analysis. It is the default chart type.

« Bar Chart: It displays the horizontal bars with the axis values. It helps to show changes
over time or differences in size, volume, or amount.

To generate a series of multiples of 11 in a spreadsheet, the maths teacher should use the
Fill Handle feature. This feature allows users to quickly generate sequences, patterns, or
series based on the values entered in a few cells.

The following step are used to use the Fill Handle to generate multiples of 11:

i.  Type 1l in the cell AL

i. Type 22in the cell A2.

iii. Click and drag to select both cells (A1 and A2).

iv. Move the cursor to the bottom right corner of the selection, you will see that the
cursor changes to a thin plus sign (+). This thin plus sign is called a fill handle.

v.  Click and hold the left mouse button and drag the fill handle over the cells you want
to fill.

The spreadsheet will automatically generate the next multiples of 11 (33, 44, 55, etc.).

A cell address is a combination of a column name and a row number such as A5, B12, H23,
etc. Using a cell address in a formula or a function is known as a cell reference.

For example, writing =H10 in cell D6 will refer to the value in cell H10, i.e., the value of D6
will be the value placed in cell H10. If any change in the value in cell H10 occurs, then the
value in cell D6 will be automatically updated.

There are three types of cell referencing which are as follows:

- Relative Referencing: Whenever a formula or function is copied to some other cell, the
address in the formula or function changes relative to the location where it is copied. This
is known as relative referencing. For example, when a formula is copied downwards
or upwards in the cell, then the change in the row number relative to the location will
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occur. Similarly, if a formula is copied horizontally either to the left side or right side,
then the change in the column name with respect to the position will occur.

Let us study the given sheet. A formula for calculating the Profit or Loss is written in cell
F9 as =E9-D9. If we copy this formula two cells up (i.e., cell F7), then the row number will
decrease by 2 and the new formula in cell F7 will be =E7- D7. Similarly, if we copy this
formula to two cells down in the same column (i.e., cell F11), then the formula will have
an increase of 2 in the row reference and the new formula in cell F11 will be =E11-D11.

Absolute Referencing: Sometimes, we do not want the address in the formula to
change with respect to the location and we need to fix a cell. Thus, if we copy the
formula anywhere across a sheet, the cell address in the formula does not change. This
fixing of a cell in a formula/function so that its location does not change with respect
to the location where it is copied, then this type of referencing is known as absolute
referencing. The dollar sign ($) is used in front of a column name and a row number
to make it an absolute cell reference, like $A$10, $F$12, etc.

Let us study the given sheet to understand the concept better. The cost price of all
five cardboards are the same, so we will fix the cell D7 by writing $ in front of the row
number and column name to make an absolute reference as $D$7. This cell will remain
the same across the whole sheet in a cell reference.
Mixed Referencing: The combination of a fixed row and a relative column like R$5,
E$10, G$23, etc. or a fixed column and a relative row like $F12, $R9, $H7, etc. in a cell
referencing is known as mixed referencing.
Type the formula =(B2 + C2) * 0.25 in cell D2 to calculate the DA of Surinder and
Press the Enter key. Now, select the cell D2 and use the Fill Handle to drag down the
formula from D2 to D8 to calculate the DA for all employees.
Type the formula =B2 + C2 + D2 - E2 in cell F2 to calculate the net salary of Surinder
and Press the Enter key. Now, select the cell F2 and use the Fill Handle to drag down
the formula from F2 to F8 to calculate the net salary for all employees.

Click on cell F9 and type the =MAX(F2:F8) to find the maximum net salary
140000
120000

100000

20000 W BASIC

sl

Surinder  Kanika Aashish  Harjit Abhijt Jyoti Amita
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Click on cell E2 and type =B2+C2+D2 in it to find the total marks scored by Arisha.

Click on cell E2 and use the Fill Handle to drag down from E3 to E6 to copy the formula
entered in E2 for other students.

Click on cell F2 and type =AVERAGE(B2:D2) to find the total marks scored by Arisha.

Click on cell F2 and use the Fill Handle to drag down from F3 to F6 to copy the formula
entered in F2 for other students.

Click on cell B7 and type =MAX(B2:B6) to find the highest score in Hindi.

Click on cell C7 and type =MAX(C2:C6) to find the highest score in English. Click on
cell D7 and type =MAX(D2:D6) to find the highest score in Maths.

Click on cell B8 and type =COUNTA(B2:B6) to find the total number of students who
appeared in Hindi.

Click on cell B9 and type =MIN(B2:B6) to find the lowest score in Hindi:

Click on cell C9 and type =MIN(C2:C6) to find the lowest score in English. Click on
cell D9 and type =MIN(D2:D6) to find the lowest score in Maths.

Enter the values of X and Y in the spreadsheet as follows:

| A | 8 | ¢ | ©o | & | ¢ | 6

1 [Value of X 2 4 6 8 10
2 [Valueof Y
3

Click on cell B2, enter the formula =3*B1+1 to calculate Y based on the value of X.

Click on cell B2 and use the Fill Hanle to drag down from C2 to F2 to copy the formula
to find the values of Y for the corresponding values of X.

The steps to create a line chart are as follows:

i.  Select the range AL:F2.

ii. Click on the Insert — Chart option from the Menu bar.
iii. Select the Line chart category.

iv. Select the Points and Lines chart type.

It will insert a chart and then you have a choice whether you want to finish the
steps or format it by following the next three tabs- Data Range, Data Series, Chart
Elements.

v. Click on the Finish button to close the Chart Wizard. A chart will be inserted.
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To create a spreadsheet for the electricity bill data from January to May as follow:

A | B | € |
1 _|Month Bill Amount
__ 2 January 1400
__ 3 |February 1510
4 |March 1350
5 |April 2100
-6 |May 2450

The steps to create a column chart are as follows:

iv.

Select the range AL:F2.

Click on the Insert — Chart option from the Menu bar.
Select the Column chart category.

Select the Normal chart type.

It will insert a chart and then you have a choice whether you want to finish the steps
or format it by following the next three tabs- Data Range, Data Series, Chart Elements.

Click on the Finish button to close the Chart Wizard. A chart will be inserted.

3000

2500

2000
1o = Bill Amount

1000

500

0

January February March April May
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5.
6.

Similarly, you can create a line chart and pie chart.

3000
2500
2000
1500 =& Bill Amount
1000
500
0
January February March April May
B January
B February
March
= April
u May

For data like monthly electricity bills, the Line Chart is usually the most appropriate choice.
This is because it clearly shows the trend of the data over time, allowing you to observe
any patterns, increases, or decreases in the electricity bill amounts across the months.

The Bar Chart is also a good option if you want to compare the exact bill amounts for
each month side-by-side.

The Pie Chart s less useful in this context since it focuses on proportions rather than trends
over time. However, it could be used to show what fraction of the total electricity cost each
month contributes.

a. Both A andR are true, and R is the correct explanation of A.
b. Both A and R are true, but R is not the correct explanation of A.

a. C.
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5. Digital Presentation

Exercise (== P oy |
8 Unsolved

Section A: (Objective Type Questions)

A. 1.d 2. ¢ 3. ¢ 4. a 5 ¢

B. 1. Workspace 2. Insert 3. Set Line Spacing
4. Format 5. Resizing

C. 1 False 2. False 3. True 4. True 5. True

Section B: (Subjective Type Questions)

A. 1. You can insert, delete, or resize rows and columns. You can also enter and edit text in a
table. You can also apply the border and colour to table.

2. InSlide Sorter view, you do the following tasks:
i.  Rearrange slides
ii.  Add or remove slides
iii. Apply slide transition
3. Slide Master is one of the most powerful tools in LibreOffice Impress. It helps you set the
default look of your slides in terms of fonts, backgrounds, images, styles, colours, and

many other things. Whatever changes you make in the slide master will be reflected in all
the presentation slides.

4. Four components of LibreOffice Impress interface are: Slide Pane, Workspace, Menu bar,
Toolbar.

5. Add the logo to the Slide Master at the bottom right corner to display it on all slides
consistently.

B. 1. a Notes View: Each slide created in a presentation has notes. Select the slide on which
you wish to add notes. The Notes view displays two sections—the upper section has
a miniature of the slide, and the lower section has an area for writing notes on the
slide. These notes are not visible during the slide show presentation but can be used
as a reference by the presenter during the presentation or taken as a printout for the
audience to have a look at important points when the presentation is going on the
screen.

-
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Slide Sorter View: In this view all the slides of the presentation are displayed in a
miniature form. It helps you check the order of the slides. In case needed the slides
can be rearranged, added, deleted or hidden. It is used to sort slides with the ‘drag
and drop’ method. The user can use this view to work with a group of slides or with
only one slide.

Master Slide: Slide Master is one of the most powerful tools in LibreOffice Impress. It
helps you set the default look of your slides in terms of fonts, backgrounds, images,
styles, colours, and many other things. Whatever changes you make in the slide master
will be reflected in all the presentation slides.

You can open the slide master by clicking the Master Slide option from the View
menu from the Menu bar.

To insert a new slide into the presentation, you can click on the Slide — New Slide
option from the Menu bar.

The steps to group object are as follows:

i.  Select multiple objects by clicking them all while the Shift key is pressed.
ii. Select Format — Group — Group option from the Menu bar.

The selected shapes will be grouped.

Closing a presentation — Ctrl + W

Moving one cell back in a table — Shift + Tab

Ungroup an object — Ctrl + Alt + Shift + G

Aligning text to right — Ctrl + R

Creating a new presentation — Ctrl + N

Grouping objects: Grouping objects means combining multiple objects into a single
unit or group. Once grouped, these objects can be moved, resized, or formatted as a
single entity. The shortcut key to group objects is Ctrl + Shift + G

Ungrouping objects: Ungrouping objects means breaking a group of objects back
into their individual components. Once ungrouped, each object can be manipulated
independently. The shortcut key to group objects is Ctrl + Alt + Shift + G

Slide: A slide is a single page or screen within a presentation that contains content
such as text, images, charts, videos, or other multimedia elements.

Presentation: A presentation is a complete collection of slides arranged in a specific
sequence to share ideas and information both visually and orally.

Bullets: Bullets are used when the sequence or order of the points does not matter.
To apply the numbering to text, go to Format — Bullets and Numbering from the
Menu bar, select a bullet style from the “Bullets” tab, and click OK.

Numbering: Numbering is used when the sequence of the points is important. To
apply the numbering to text, go to Format — Bullets and Numbering from the Menu
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bar, click on the Type drop-down list to choose a numbered style, and click OK.

Animation: An animation refers to the addition of visual effects to objects on a slide.
These effects can make objects appear, disappear, move, or change in other ways
during a slide show. Animations can be applied to various elements such as text,
images, shapes, and charts to make the presentation more dynamic and engaging.
We use Normal view to apply animation to the objects.

Slide Transition: Slide transitions are effects with or without sounds that take place
between slides when slides appear one after the other in a presentation at the time
of the slide show. A single type of transition effect can be applied to all slides, or a
different transition effect can be applied to different slides in a presentation. Slide
transitions can be added to the slides in the Normal view and Slide Sorter view.

To create a presentation for the class assembly, Superna needs to prepare the following
slides:

i.
ii.
iii.
iv.
V.

Vi.

Vii.

Title Slide: "Class Assembly Presentation” by Superna.

Class Performance: Insert video of class performance.

Plantation Drive: Show photos from the event.

Old Age Home Visit: Display images from the visit.

Triumph of the Elderly: Share a brief story or achievements of residents.
Thank You Note: Express gratitude to the Principal and others.

Closing Slide: “See You Next Time!”

To create a presentation, Rohan needs to prepare the following slides:

i.
ii.
jii.
iv.
V.

Vi.

Vii.

Title Slide: Introduce the advertising plan with client name and presenter.
Advertisement Concept: Outline the core idea, target audience, and objectives.
Advertising Medium Mix: List and justify the selected advertising channels.
Sample Creative: Display visual examples of ad designs and slogans.
Budget Overview: Provide a cost breakdown and budget allocation for each medium.
Expected Outcomes: State projected results and key metrics for success.
Closing Slide: Summarise key points and suggest next steps.
To create presentation perform the following steps:
i.  Click on the File —» New option from the Menu bar.

The Select a Template will appear.
i. Choose atemplate as per your choice by clicking on it.
iii. Click on the Open button.

The selected template appears in the form of a title slide layout

iv. Add the relevant content in it.
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v. Click on the New Slide icon in the Presentation toolbar to add new slide and
add the relevant content.

Similarly, add more slides in the presentation.
Use the different options related to Font from the Text Formatting toolbar.
To save a presentation in PDF format, follow the given steps:

i.  Click on the File - Export As — Export Directly as PDF option from the Menu
bar. The Export dialog box appears.

ii. Navigate to the location where you want to save the file.
iii. Type an appropriate name in the File name text box.

iv. Click on the Save button.
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